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Licensed Home Care Services Agency Statistical Report and Registration Forms on Universal Data 
Collection System (UDCS) Instructions 

 
 
Please see Attachment A at the end of this document – it contains descriptions to all items on the tool bars 
located on the top of the Report Manager worksheets. 
 
General Information: 

• Enter information in the blank white fields.  All other fields (pink, lavender, and brown) are read-only 
fields.  You can leave white fields blank if you have nothing to report – you do not have to enter zeros. 

• A few fields are required.  If they are left blank, you will not be able to submit the report.  The field 
header will indicate that the field is required. 

• Some fields require a Yes or No answer.  You must double click on the blank field and choose Yes or 
No from the box.   

• Some forms have validation edits to ensure accurate information is collected.  The validation edits are 
described in these instructions. 

 
Note: This documentation has been updated from previous versions. Images may be from previous 
report years. Dates in the text have been updated for the current report year (2022).  
 
To Begin: 
 
Once you have downloaded the Report Manager software and report shell (see the separate downloading 
instruction document): 
 

• To start a new report, click on the Start New Report icon or to resume working on a previously saved 
report click on the Open Existing Report icon. 
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Once you have started a new report or opened an existing report, a box will pop up which is the Configure 
Report Organization.  In this box, you will select your organizations name from the drop-down box in the 
organization line.  If your organization is not listed in the drop-down click on the box that states Organization 
Not found In List for further instruction.  In region section you will have to select statewide.  Then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will then see a report configuration box.  Click the Next tab in the bottom right corner. 
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A second report configuration box then appears with the title CheckBox List Panel.  This is where you will 
select the counties that your agency serves.  For example, if you have served patients for this reporting year in 
only three counties you would ONLY pick those three counties in this county list. Once you have done so, 
click the Next tab at the bottom right corner.  
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A third report configuration box will appear once you have completed selecting your counties of service.  
Click Finish in the bottom right-hand corner. 
 

                                                
Important Note:  After you have clicked finish, if you need to make a revision to the counties that you 
have selected this can be done by selecting “Configure” and “Report Configuration” from the top tool 
bar.  After you have made the revision, you will be prompted to replace your current .pnp file with the 
revised file.  Click yes to replace the current file.   
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General Information Form 
 
The General Information Form is part of the Report Manager Software and collects information about your 
organization that not only identifies you but enables the submission and certification of your report as well as 
the successful transfer of your data to a data repository.   
 
 
When you open the report, you will receive a pop-up box that requests that you fill in the General Information 
Form.  You must fill in the General Information Form prior to submitting the report. 
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The General Information Form information section will be filled in for you.  You only need to fill in the 
Contact Person and Address sections. 
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Form LSR1 – Agency Form 
 
Form LSR1 - Agency Form collects agency location, contact information and other information.  
 

 

 
 
 
Agency and Contact Information Section 
All fields in this section, except for NPI number, are required fields.  You will not be able to submit the 
statistical report if this information is not filled in. 
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Important Note for ALP LHCSAs –  
The ALP LHCSA Statistical Report will be posted on the UDCS Platform this year and will include the 
DOH Registration form. 
 
If your LHCSA serves patients in an Assisted Living Program (ALP) there are two options: 
 

• If your LHCSA serves patients in the community as well as ALP patients, you must submit both the 
Annual LHCSA Statistical Report regarding your community patients and the Annual ALP LHCSA 
Statistical Report regarding your ALP patients. 
 

• If your LHCSA EXCLUSIVELY serves patients in an ALP program, you only need to submit the 
Annual ALP LHCSA Statistical Report – you do not need to submit any part of the annual LHCSA 
Statistical Report. 
 

Agency Information and FIs for CDPAP Sections 
The fields in these sections require yes or no responses.  You must double click on the blank space and the 
box with the choices will appear. 
 

 
 
 
 
Validation Edit – Your answer to the question “Did this agency serve patients during the report year?” on 
row 16 of form LSR1 must match your answer to the question “Did this LHCSA provide patient care services 
during the last year?” on row 4 of form LSR10.  
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Form LSR2 – Patient Form 
 
Form LSR2 - Patient Form collects patient demographic information, including discharges and referrals.  
 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
 



Send questions to hcstatrpts@health.ny.gov   pg. 10 
 

Patients Section 
Enter information for Patient Census.  Enter the patient census as of December 31 of the report year.  Patient 
Census means the actual number of individual patients receiving services on December 31 of the report year 
(12/31/22 for the 2022 report year). 
 
Next, enter the total number of cases in the Total Cases field. A case is an episode of care with a start date 
(admission) and an end date (discharge).  Multiple types of service may be provided during an episode of 
care.  For an episode of care to count as a case for this report the admission date must be in this reporting year 
or prior year(s), and the discharge date must be in this reporting year or the patient must still be receiving 
services at the end of the reporting year.  A patient who has been seen only to be assessed for personal care 
services should not be counted as a case, and these visits should not be reported.   
 
A patient sometimes represents more than one case.  However, DO NOT count a patient as a new case if any 
of the following conditions apply: 

• The patient’s age category was changed during the report year 
• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 
• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 
 

Validation Edit - The number of cases entered on row 2 of LSR2 must match the total of the “Referred 
From” column on row 30 of LSR2. 
 
Enter the Unduplicated Patient Count in the next field.  This is the total number of discrete individual 
patients that your agency has served in the year, regardless of the number of admissions and discharges that 
patient may have had.   A patient is only counted once regardless of the number of cases they represent. 
 
To recap, if a patient is receiving care on 12/31/2022 they will be included in the patient census count. If they 
had two admissions during the year, they will count as two cases but as only one unduplicated patient.  
 
Validation Edit - The unduplicated patient count entered on row 3 of LSR2 must match the total of the 
unduplicated patients reported on forms LSR7 – Services by County Form.  This total is displayed on row 999 
in the first section of LSR2 – Patient Form. 
 
Length of Stay Section 
Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or 
case. Length of stay should be calculated from the date the patient was initially admitted for an episode of 
care, regardless of the year of admission, to the date they were discharged.  For example, if a patient was 
admitted on 12/30/2021 and discharged on 1/10/22 her LOS is 12 days.  Count the 2 days in 2021 and the 10 
days in 2022 to arrive at a 12 day LOS.  Patients that were discharged to a hospital or RHCF and readmitted to 
the agency within 30 days with the same illness or diagnosis should NOT be counted in the length of stay 
section. 
 
Validation Edit - The total number of discharges calculated from the LOS entries on row 10 of LSR2 must 
match the total number of discharges calculated from the “Discharged To” section on row 30 of LSR2. 
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Referrals and Discharges Section 
The next section collects patient referral and discharge information. In the “Referred From” column enter the 
number of cases served by your agency that have been referred from each of the designated sources regardless 
of their start of service date. This means that if you are serving a case in 2022 that was referred to your agency 
in 2021, that case should be counted.  Patients that were discharged to a hospital or RHCF and readmitted to 
the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section. 
 
In the “Discharged To” column enter the number of cases discharged during the reporting year to specific 
destinations.  
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Form LSR3 and LSR4 – Revenue Form 
 
Form LSR3 and LSR4 – Revenue Form has two sections  
 
LSR3 – Contract Revenue Form collects information about revenue received from contracts with other 
agencies to perform services for their patients or provide equipment to their patients. 
 
LSR4 – Direct Revenue Form collects data on revenue from services provided to patients directly served by 
your agency (i.e. services are not provided on behalf of another agency).  Direct services may include private 
pay, commercial insurance, and worker’s compensation cases. 
 

 



Send questions to hcstatrpts@health.ny.gov   pg. 13 
 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
 
Please note that data on Nursing Services is collected as visits, instead of hours.  If your agency records 
Nursing Services in hours, please count 2.5 hours as 1 visit. 
 
Contracted Services Section 
Begin by answering the Perform Services Question - If your agency DID NOT perform services for, or 
provide equipment to, the patients of other agencies under contract during the report year, answer the first 
question “no” and move down to the Direct Services section of the form.  You may leave the columns blank 
and do not need to enter 0s in these columns.   
 
If your agency DID perform services for or provide equipment to the patients of other agencies under 
contract, enter “yes” for the first question. Enter the number of contract hours and revenue by the type of 
service if you have contracted with another agency, usually a CHHA or an MLTC plan, to provide service on 
their behalf.   
 
Direct Services Section 
Enter the number of hours and revenue by the type of service.   
If your agency did not provide any services directly to any patients, leave the columns blank (you do not have 
to enter 0s). 
 
For both the Contracted Services and the Direct Services - the Gross Revenue is the total revenue received 
for the services or equipment provided before any deductions or allowances. 
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Validation Edit – If there is an entry made in the hours or visits column, there must be a corresponding entry 
made in the gross revenue column.  
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LSR5 – Cost Form 
 
LSR5 – Cost Form - collects data on costs for providing services to patients.  Costs are divided into direct 
and indirect costs.  
 
Direct costs are costs that are clearly associated with the provision of home care patient services. Examples of 
direct costs are staff wages, transportation costs, consumable supplies such as gloves and masks, and the cost 
of providing in-service training to aides.  
 

 
 
 
Indirect costs are fringe benefits and payroll taxes as well as costs for activities and materials that are used by 
the entire agency.  
 
The indirect costs are broken out by fringe benefits and other indirect costs, such as administrative and 
general costs, capital and related costs, and other operating costs. 
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• Administrative and General costs are expenses for activities and materials that are used to administer 
your business. Examples are rent, utilities, and office supplies. 

• Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the 
agency, etc. 

 

 
 
 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
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LSR6 – Staff and Wages Form 
 
LSR6 – Staff and Wages Form - collects information by staff type for full time and hourly staff at two 
different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe 
benefits.   
 

 
 
 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
 
Enter the number of full-time and hourly staff at your agency on April 1 and October 1 of the reporting year. 
The current definition of a full-time staff is someone who works an average of 30 or more hours a week and 
130 hours or more per month.   
 
Validation Edit – the number of HHAs entered in each of the 4 first columns must not exceed 17,000. 
 
Validation Edit – the number of PCAs entered in each of the 4 first columns must not exceed 17,000. 
 
Enter the number of W2s issued during the year for each staff type. 
 
Validation Edit – the total number of W2s must not exceed 25,000. 
 
Enter the total hours worked, total wages paid, and total fringe benefits paid for each staff type.  The amount 
of wages plus fringe benefits will be calculated in the first lavender column.  The second lavender column will 
divide the total wages (not including fringe benefits) by the total number of hours to calculate an average 
hourly wage.  In the next two columns, enter the lowest hourly rate paid and the highest hourly rate paid for 
each staff type. 
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LSR7– Services by County Form 
 
LSR7 – Services by County Form - collects data on services provided by county.  There is a sheet for each 
county that you chose when you started the report.  The LSR7 worksheets were put at the end of the list of 
worksheets on the left-hand side of the screen. 
 

 
 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
 
For each County that your agency provides services: 
 
Enter the number of unduplicated patients in each of the age cohorts: 

• Under age 21 
• Age 21-64 
• Age 65+ 

These amounts are automatically calculated in the lavender field in the first column. 
 
Enter the number of new admissions during the report year.  
 
Validation Edit - The amount entered as new admissions must be less than or equal to the unduplicated 
patient count. 
 
An unduplicated patient is an individual who has received at least one episode of care and may have 
received more than one.  Regardless of the number of episodes in the reporting year, the individual is only 
counted once. We are asking for the unduplicated patient count to be broken out in cohorts of age groups.  
Please count the age of the patient at the first episode of service (if service was initiated during the report 
year), or if the patient started service in a prior year count their age at the beginning of the year. 
 
New admissions are patients that have been admitted to the agency during the reporting year.  Patients that 
were admitted at a previous time during the report year (or in prior years) and discharged and were admitted 
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again during the report year should count as a new admission at the time of admission, with the following 
exceptions: 
DO NOT count a patient as a new admission if any of the following conditions apply: 

• The patient’s age category was changed during the report year 
• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 
• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 
 
Nursing services captures data about nursing services provided to patients in the selected county. The data is 
then broken out by cases and visits and age category.  If your agency records Nursing Services in hours, 
please count 2.5 hours as 1 visit.  In addition, if your agency is part of the Nurse Family Partnership – the 
number of nursing service cases and visits should be recorded in the selected county.  The Nurse Family 
Partnership is a program in which nurse home visitors work with low-income young women who are 
pregnant with their first child, helping these vulnerable young clients achieve healthier pregnancies and births, 
stronger child development, and a path toward economic self-sufficiency. 
 
All other services provided to patients in the selected county must be recorded below the Nursing Services 
row. The data is then broken out by cases and hours and age category.   
 
A case is an episode of service with a start date (admission) and an end date (discharge).  Multiple services 
may be provided during an episode of service.  For an episode of service to count as a case for this report the 
admission date must be in this reporting year or prior year(s), and the discharge date must be in this reporting 
year or the patient must still be receiving services at the end of the reporting year.  A patient who has been 
seen only to be assessed for personal care services should not be counted as a case and these visits should not 
be reported.   
 
A patient sometimes represents more than one case.  However, DO NOT count a patient as a new case if any 
of the following conditions apply: 

• The patient’s age category was changed during the report year 
• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 
• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 
 
Validation Edit -   If you enter an amount in the “Cases” column you must enter an amount in the 
corresponding “Hours” column.  Also, if you enter an amount in the “Hours” column, you must enter an 
amount in the corresponding “Cases” column. 
 
Validation Edit - If you enter amounts in the cases columns you must have an amount entered in the 
unduplicated patient count.  Conversely, if you have an unduplicated patient count, you must have amounts 
entered under cases.  
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LSR7A – Wellcare  Form 
 
LSR7A – Wellcare Form - collects data about Wellcare services provided to patients. Wellcare services 
include services which have as their primary purpose the prevention of illness and obtaining optimum health 
for their recipients.  Examples of such services are nurses performing lead screening assessments, providing 
maternal and child health education, or following up on communicable diseases.   
 
Only County-Operated LHCSAs that provided wellcare services need to complete this form. 
 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
Nursing services captures data about nursing services provided to patients in the selected county. The data is 
then broken out by cases and visits.  If your agency records Nursing Services in hours, please count 2.5 hours 
as 1 visit.   
 
Private Duty Nursing Services captures data about nursing services provided to patients in the selected 
county. The data is then broken out by cases and hours.    
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LSR8 – Contracts  Form 
 
LSR8 – Contracts Form - collects information on your agency’s contracts to provide services on behalf of 
another agency.  
 
 

 
 
 
If your agency did not have any contracts to provide services for another agency, answer No to the first 
question, and you are now finished with this form. 
 
If your agency did have contracts to provide services on behalf of another agency, answer Yes to the first 
question, and enter the information for the contract(s).  
 
If it is available, enter the license number/operating certificate number for the agency with whom you are 
contracting. CHHAs and Hospices will have operating certificate numbers. Other organizations may not have 
an operating certificate number.  Enter N/A if the organization does not have an operating certificate or 
license number. 
 
Operating Certificate numbers can be found in the Home Care section on the Profiles webpage 
https://profiles.health.ny.gov/home_care/index.  Hover the mouse at the Home Care tab and you will see 
several ways to search for an agency.  Once you find the agency you are looking for, click on the overview tab 
and open the administrative section.  
 
Enter the number of HHA and PCA hours of service you provided under this contract and the amount your 
agency was paid per hour of service.  
 
If the requested information for a given contract changed during the reporting year, enter it as two or more 
separate contracts. 
 
  

https://profiles.health.ny.gov/home_care/index
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LSR9WFA – Workforce Form A 
 
LSR9WFA – Workforce Form A - collects information on admissions and the number of cases by 
authorized hours per week for all services. 
 
 

 
 
An agency is closed to admissions when the agency is not accepting any new patients.  This would not 
include times during the reporting year when an agency receives a referral list, fills cases it is able to, and 
does not take cases it is unable to.  However, if the agency is not accepting any new cases due to reasons such 
as staffing and scheduling constraints, it should be included in this count.  Do not include days, such as 
holidays, if the agency would not normally accept a new case on that day. 
 
An agency is unable to fill the total hours approved for a case if the case is approved for a certain number 
of hours, but the agency is not able to fill the total number of approved hours with its current workforce for 
any reason.  Cases that are unfilled because someone calls out of work one day should not be included in the 
response.  
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LSR9WFB – Workforce Form B 
 
LSR9WFB – Workforce Form B - collects information on number of staff employed and assigned to cases, 
and the number of open positions at two points during the year.  This form also collects the number of staff 
that have been employed by your agency for the full report year and the number of staff that have left your 
agency during the report year. 
 

 
 
The number of staff employed on April 1 and October 1 is totaled (count of full-time staff plus count of 
hourly staff) and forwarded from form LSR6 – Staff and Wages Form.   

• Enter the number of staff assigned to cases on April 1 and October 1 of the reporting year.  This means 
staff that have cases assigned to them as of that date, not just staff actually working a case on that date.  
For staff not providing direct care, such as administrators or administrative staff, enter a “0” in the 
response. 

• Enter the number of Open positions on April 1 and October 1 of the reporting year.  A position is 
considered open when an agency has advertised for a position, but it is not filled.  This includes both 
hourly and full-time positions.  If an agency is continuously recruiting for any of the job categories, it 
should quantify the number of workers it would need to hire to be considered fully staffed in that 
category. 

• Enter the number of staff (full time and hourly) that have remained employed by your agency for the 
full report year or more.   If an employee is terminated and rehired during the report year, they should 
not be included in this total. 

• Enter the number of staff (full time and hourly) that have left your agency (no longer employed by 
your agency) for any reason during the reporting year.  This is a count of workers who left their 
position for any reason – voluntary or involuntary – excluding promotions.  
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LSR9WFC – Workforce Form C 
 
LSR9WFC – Workforce Form C - collects employee benefit information for four types of employees, and 
non-wage supports for all staff. 
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Employees that receive health insurance or retirement plan benefits through the union, if the agency pays into 
the benefit, should be counted as enrolled in employer-provided health insurance or employer-sponsored 
retirement plan.   

Short-term disability insurance may include the required coverage under New York State law or supplemental 
coverage that the agency offers.  
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LSR10 – Registration Form  
 
LSR10 – Registration Form - collects an attestation that indicates the LHCSA is currently operational and 
serving patients.  If the LHCSA has opened in the past year, you can report on the form that the LHCSA is not 
yet operational and is currently not seeing patients.    
 
Some fields on this form are required fields.  You will not be able to submit the statistical report if this 
information is not filled in. 
 
The appropriate Governing Authority Representative must request that the LHCSA be registered with the 
Department of Health for the upcoming calendar year.  
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Validating the Statistical Report 
 
You may, at any time, Validate the Sheet you are working on, or validate the entire Report.  You must 
validate the report before submitting it. 
 
Go to the top tool bar and click on the drop down box next to the green arrow. 
 

 
 

 
 
You can validate a worksheet at any time.  You can also refresh the validation after it’s been done once by 
clicking the refresh circle in the details portion of the report.  Because there are so many worksheets, it may 
be easier to validate each worksheet once you’ve finished it.  The results of the validation are in a table in the 
details section of the worksheet.  The message that says “Rule Passed Validation” is only referring to the cell 
you are on – not the whole worksheet. 
 

 
 
 
The details section is automatically set up to show all rules.  It’s only an error if there is a checkmark in the 
error box 
 

 
 
 
To see if you have any cells with errors – click on the filter in the details section and change it from “all rules” 
to “critical errors”. 
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Validations can be done for the worksheet you are on by checking the box that says “Current Worksheet” or it 
can be done for all worksheets by unchecking the box.   
You can fix an error and then re-run the validation by clicking on the refresh circle. 

 
 
 
If you have passed the validation edits you will have no error boxes checked and get a green message that 
says Rule Passed Validation for each cell you choose. 
 
Finalizing the Statistical Report 
 
If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on the 
Finalize Report icon. 
 

 
 
 
Or click Action on the top tool bar and choose “Finalize Report” 
 

 
 
 
A message will come up asking if you are sure you want to save and finalize.  Click Yes. 
A second message will come up directing you to correct errors (if there are any) or letting you know that the 
report has been finalized. 
 
Select a location to save your Finalized Report. Make sure that you are aware of where it is being saved 
(i.e. desktop) as you will need to find the file when you upload it onto the Healthcare Financial Data 
Gateway.  You may wish to make a new folder on your desktop and save it there. 
You will save a PDF of the report, as well as a .pnp file of the report. 
 
The name of the report will be: 
LHCSA_Agency Name_(Agency License Number)_Statewide_2022_A00.pnp 
 
The file you will want to upload will end in “.pnp” 
 
Your report is now ready to be submitted to the Healthcare Financial Data Gateway. 
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Submitting the Finalized LHCSA Statistical Report to the Healthcare Financial Data Gateway 
 

1. Login to the HCS.  
2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the 

Healthcare Financial Data Gateway main page.  
 

 

 
 
 

3. Click the Submissions tab – the Submissions page will display 
 

 
 

4. Select LHCSA as the Submission Type and your organization from the Organization list and then 
click the Search button. The Submission page will be expanded. 
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5. Click the Browse button to display a dialog box that allows you to locate your finalized LHCSA 

Statistical Report. It will have a .pnp file extension.  
6. Once you have selected the file to submit, click the Submit button. 
7. The Submission History section of the Submission page will be updated to reflect the status of the 

submission. 
8. A confirming email message will be sent to the email address listed in the New Submission section of the 

Submission page. 
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Attachment A – Report Tool Bar items 
 

Worksheets 

Worksheets 
 

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application 
window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view 
that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to 
collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix 
Panel. 

Title Bar 

Title Bar 
 

The Title Bar is located at the very top of the window and will display the name, version and software build 
number, followed by the name of the active matrix table if a table is currently open. 

 

Menu Bar 

UDCS Menu bar 

 
The following Help Topics will guide you through the menu bar functionality. 

 
File 

The File Menu. 
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Report Manager: Select Report Manager to return to the Report Manager.  
 

New: This command will start a new Report 
 

Open: This command will enable you to open an existing Report 
 

Save: This will save the Report you are working on. 
 

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location 
that you choose. Your working report location will remain in the default location: 
C:\ProgramData\UDCS\report 

 
Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel 
document or a PDF document. For either option, the Select Worksheets window will open. Check the 
worksheets you wish to export or check Select All to check all of the worksheets. You will be prompted to 
save the export file to a location you choose. You can then open the file from this saved location and print. 

 
Close Report: Closes the Report. You will be prompted to save your data first. 

 
Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data 
first. 

 

Edit 

The Edit Menu 
 

Cut, Copy, Paste, Undo 
 

 
These features will enable you to copy data from one part of your report to another, or from Microsoft Excel 
to your Report with some limitations: 
1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to 
numeric type cells. 

 
2) You may not paste data into read only cells such as targets of formulas. 

 
3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If 
the range size does not match, you will not be allowed to copy the data. 
For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has 
read only cells, you will be alerted to adjust your range. 
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View 

The View Menu 
 

 
 

Report Type: You can choose to Select All Worksheets to display all of the worksheets in the Report in the 
Worksheet display panel. For Reports that have multiple Report Types, you may choose to select only the 
worksheets from the selected Report Type. 

 
Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to 
collapse the worksheet panel when you are working on a large worksheet and could use extra space to see 
more of the worksheet. 

 
With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to 
expand the worksheets. 
Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets. 

 
Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works 
similarly to expand-collapse worksheets. 

 
The following menu items will each open a window that will enable you to Export the data as a text file. 
Calculations: A window will open that lists all of the mathematical expressions in the Report. 

 
Text Transfers: Lists all of the Text Transfers in the Report. 
Text Transfers consist of a value and a target. Once the value is entered, the target 
automatically get populated with the same value. 

 
Validation Rules: Lists all of the Validation Rules in the Report. 
Validation Rules are conditions that must be met in order for the report to be completed 
satisfactorily. 

 
Submission Output: This is the XML output of the Report. It lists Report configuration information 
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as well as class code/line numbers and the values that were entered for them. 
 

Configure 

The Configure Menu 

 
 

Control Data: Contains information that is required in order for the Report to be completed correctly and 
allowed to be submitted. All required Control Data fields must be complete. Required fields will have a red 
exclamation point next to them. When you open the Report, you will be alerted if the Control Data 
information is not completely filled out. 

 
Report Settings / Report Types: These menu items are merely instructions to remind you what to do in the 
event that you have created your report using the wrong configuration information, such as the wrong Report 
Type or wrong Region. Click on the File menu to Start a New Report. Select the correct settings and then 
transfer your data from the incorrect Report to the new Report. 

Action 

The Action Menu 
 

 
Validation Method: Current Worksheet or Entire Report. 

In order to Finalize the Report for Submission you must run it through the validation process. You can 
validate to check only the current Worksheet or you can run Validation for the entire Report. You must 
Validate the entire Report in order to pass Validation and have a Finalized Report that is ready to submit. 

 
Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire 
Report you can select the Start Validating item. For larger Reports, you may choose to Stop Validating at 
any time. 
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Notepad 

The Notepad Menu 
 

This is a scratch pad to keep notes and provide additional information while you complete your report. Click 
the File menu and then Save to save Notes to your Report. Use the File and Edit menu as you would a 
typical text editor. 

Windows 

The Windows Menu 
 

Use the Windows commands to arrange the Worksheets to your satisfaction. 
Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to 
bring it to the front of the Report. 

 

 

Search 

The Search Menu 
 

Enter what you would like to search for in the Search box and click the Search button. 
All results that match your Search criteria will be listed below. You may choose to Search 
the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window. 

Help 

The Help Menu 
 

View Documentation will open the Help File that you are currently reading. 
 

 
Click About to open the following window. This information contains details about the Report you have open 
as well as the versions of the software and files being used. 
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Icon Menu 
 
Icon Menu 
 
 
 
 

        Open the Control Data Form. 
 
 
 
 

         Start a New Report. 
 
 
 

       Open an Existing Report. 
 
 
 
 

        Save the Report. 
 
 
 
 

        Close the Report. 
 
 
 
 

        Validate the Current Worksheet or the Entire Report. 
 
 
 
 

        Stop the Validation process. 
 
 
 
 

        Finalize the Report. 
 
 
 
 

        Open Notepad. 
 
 
 
 

        Open the Previous Worksheet. 
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         Open the Next Worksheet. 

 
 
 
 

         Export the Worksheet as a PDF document. 
 
 
 
 
 

         Export the Worksheet as an Excel file. 
 

          Open the Search Window. 
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